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INSTALLATION 

Insert the CD into the computer and follow the steps to install the software. 

A valid serial number is required to complete the installation. 

The serial number should be included in this manual, or as an insert in the box, CD or 
invoice. 

If you are experiencing problems with the serial number being accepted, please verify 
that you haven‟t mistakenly entered a number in place of a letter and vice versa. 

For example a “0” zero instead of the letter “O” 
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QUICK SETUP 

DON'T LIKE READING THE MANUAL, WATCH OUR VIDEOS ONLINE. 
Voice narrated movies provide you with step by step instructions on how to use 
important VISEC features, such as: 

How to Install VISEC 
Viewing Video Surveillance 
Using a Camera 
How to setup Motion Detection, Picture Alerts, and FTP for emergency backup storage 
And Much more…. 

Visit http://www.visec.net/support.htm for more information. 

(1) Connecting Camera(s) – Analog Cameras, USB cameras, or IP cameras

Before you start the VISEC program you should indentify the type of camera you are 
going to use. The most common type of cameras and what Visec supports 

USB cameras connect directly to your USB computer. USB cameras are 

usually used for video conferencing. 

http://www.visec.net/support.htm


Visec Surveillance Software Manual.     

Copyright © 2019 Global Technology Asset Partners Inc.  
All rights reserved. Visec is a registered trademark of Global Technology 
Asset Partners Inc.  

 Analog cameras are the most common cameras on the market today. Analog 

cameras cannot connect directly to your computer and require a capture device. 
Usually a capture card or usb capture box. 

Capture Card- Connects inside Computer and analog camera connects to it. 
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IP cameras are the newest in technology and are basically cameras with 

computer chips that act like servers and send images digitally across the network 
via a router. 

IP Camera Setup 
a) connect IP camera to router in the area designated LAN port

b) Or connect IP camera to an available switch that is connected to a router
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c) Or connect IP camera to a Power Over Ethernet Switch connected to a
router

Each particular camera should have its own installation procedure.  
Some require you to run the manufacturer‟s install cd to setup the camera. 

You should refer to your camera manufacturer's instructions if you have difficulty or 
specific technical questions. 

For the most part, installing a camera is very easy. Most USB Cameras are 
automatically detected by the Windows Operating System when initially plugged in. 
Usually Windows will ask you for a driver when plugging in a new camera. Follow the 
instructions from your camera vendor to make sure the camera is correctly installed. 

Most IP cameras are found automatically by Visec when connected to a network. 
Visec does a network scan and looks for all known IP cameras. 

(2) Open the VISEC program

Open the program by clicking the VISEC ICON   

or you can choose, START > PROGRAMS > VISEC 2009 

By default, the program is located at:  

Copyright © 2019 Global Technology Asset Partners Inc.  
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C:\Program Files\Visec 2009\Visec.exe 

(3) Set Up- select camera

(a) Camera setup

View > Video Devices,  lists all cameras installed.  

Please choose: View > Video Devices as shown below: 
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Shown is a list of cameras installed on your system. 

Usually this does not mean that you have all of these cameras connected, rather at one 
time or another they were installed on your computer. 

Please place a check    next to the cameras you wish to use. 
Press OK when done.  This will instruct VISEC which cameras it can use. 

Installing an IP camera 

Most popular ip cameras are integrated with Visec such that Visec constantly scans the 
network looking for cameras. If Visec sees a new camera installed Visec will 
automatically tell you this when the program is loaded or when it finds it. 
You will see a “New IP camera found, click to add 

Double Clicking will launch a new window with the IP camera parameters 
allowing you to add it to Visec. 
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Address/URL: On automatic setup, Visec automatically enters the know path here. 

Refresh Interval: On automatic setup Visec also sets this. Usually this field is rarely 

used on newer cameras 

Login: make sure to enter the camera‟s proper login or username here. 

Password: make sure to enter the camera‟s proper password. 

Manually Adding an IP Camera 

If Visec did not see or locate the camera on its automatic scan you can try to manually 
scan for the camera again 

PRESS THE SCAN BUTTON 
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Select the Camera you wish to add and it will display as shown below. 

If required make sure the correct login and password are entered. 
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Opening The Camera 

You are now ready to start using the VISEC Program. The first thing we need to do is 
choose which camera to turn on. 

To do this: 

Select Camera, then Open. This will open a new camera window allowing you to see 
video from your camera. 

 Or you can press the Camera button to open one camera at a time or the button next 

to 

Copyright © 2019 Global Technology Asset Partners Inc.  
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it to open all cameras. 

After opening a camera, the video will be displayed like this: 

If you do not see this screen make sure your camera(s) is/are plugged in and properly 
installed. You can also review our Troubleshooting Video Problems for more help 
(located at the end of this manual).  

Copyright © 2019 Global Technology Asset Partners Inc.  
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Configuring Visec General Features 

You can configure VISEC by choosing Edit and then Preferences from the menu. 

Or Press the  button 

Here, you will be able to control all the features: 

Please Choose Where VISEC Should Store Video- Allows you to change the location 
where video is saved. 

Maximum Disk Space to Use- This is the amount of disk space that you want VISEC to 
be allowed to use. We suggest using as much as possible. Note if your hard drive was 
750gb you could for example allocate 400gb to Visec by entering 400 in the field. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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Automatically delete old video footage- By choosing this option, VISEC will delete old 
footage, (day by day) to make room for new footage. For example, if you have 20 days 
of recorded surveillance footage, and you ran out of space, VISEC would start deleting 
from the oldest day, which is Day 1. This feature will allow you to avoid running out of 
storage space. 

Make sure you understand what you are doing before setting VISEC to delete any old 
video. You may have important video that you don‟t want deleted. 

Keep log files in folder- By selecting this option, VISEC will keep a log of all users who 
have attempted to login remotely, whether successful or failed. The log file will include 
the date, time, user's IP address and if the user successfully logged-in or not. If the user 
incorrectly logged in, VISEC will display the password entered by the user. 

Start Up Options 

You can choose to have VISEC load automatically when your computer reboots and 
when Windows loads. To enable this option check the  

Automatically load Visec on startup 
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Start in secret mode using the Hot Key created- This will load the program at startup 
in secret mode automatically. 

Secret Mode 

You can have VISEC run secretly in Secret Mode. 
When in Secret mode, the program cannot be seen on a computer. The program is NOT 
in the system tray, nor minimized. The program is invisible and virtually unnoticeable, 
even though it is really in full operation. The purpose of Secret Mode is to let you monitor 
your cameras, while at the same time allow you to keep the program hidden. 
Additionally, even if another person is using your computer while VISEC is in secret 
mode, Visec will be virtually undetectable. 

To initiate Secret Mode, press the icon: 

You will then be prompted to set a HOT KEY combination. 
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The Hot Key Function is setup to allow the program to run in secret mode. Pressing the 
Hot Key which you defined in the menu will make the program reappear when in secret 
mode. For help troubleshooting the Hot Key see: Hot Key Support in the 
TROUBLESHOOTING section at the end of this manual. 

Permissions 
Visec has an advanced permission based system where users can add different 
levels of privilege to login Visec.  

To enable this, check:  Enable user-level access 

You can then choose User List to manage users. 
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Editing Camera Properties 

You can configure a previously added camera by either 

a) right clicking on the camera window -> choosing properties

b) Or Choose View Devices -> Properties



Visec Surveillance Software Manual.     

General 

The general section lets you configure the 
following:

Description: This is the name of the camera,  e.g. Parking Lot 

State:  Check this box to tell Visec that this camera is enabled. Enabled means it will 
open when the camera icon button is pressed.  
E.g. if selected this camera will be opened when one of these buttons are pressed.The
first button opens one camera at a time and the second button opens all available
cameras.

 Automatically open this camera when Visec is started- If you check this box Visec 
will open this camera automatically when Visec starts. This is good if the computer 
reboots or looses power for some reason. This allows Visec to run itself without user 
intervention to open a camera. 

Note: If you want Visec to load after a computer looses power you must enable a 
resume power state in your motherboard. Not all computers automatically reboot when 
the power goes out and comes back on. 

Video Source Type:  Interlace or Progressive. 
Select the type of video this is.  

Copyright © 2019 Global Technology Asset Partners Inc.  
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Interlaced Video - Almost all analog cameras are interlaced (video that breaks down an 
image into odd and even sections) (note if you use analog cameras see filters below on 
how to deinterlace video) 

Progressive- Most new IP cameras are progressive. (All pixels of the image are done in 
sequence) 

If you are using an analog camera (e.g. a capture card) you would select Interlaced. 
If you were using an IP camera you most likely select progressive. 

Time Stamp – Select where you would like a timestamp of the image to display. 
(Note you must also  enable time stamp in the recording tab as explained below) 

Maximum Recording Rate- you can select to reduce the recording frame rate by 
selecting the box and choosing the desired option. The main reason to reduce this is to 
save disk space.  

Motion Actions  -Email Alerts, Access Control and Triggered Actions 

VISEC can monitor your environment and then alert you when it detects motion (such as 
from someone entering a room) 

You can choose to receive an email with images of the motion or perform another action 
that was detected along with a short text message. 

To use this feature, you must have a valid email account. 
Most ISPs usually provide this standard with your Internet Service. 

To receive notifications: 

1) Right clicking on the camera window -> choosing properties

b) Or Choose View Devices -> Properties
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 Then choose: MOTION ACTIONS – Press New 

You can then select the Action to perform: 
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Axis Camera I/O 

You can instruct Visec to control a relay output using a camera supported (currently Axis 
IP Brand). The action name entered can be any label you like it to be. In this example I 
called it Open Gate. I would off course need the output connected to a gate controller 
device. 

Digital Output 

Digital output is the Visec Access Control feature using the brand: Moxa (a separate I/O 
hardware module to purchase) 
This is based on opening or closing a circuit. Different types of sensors can be 
purchased, including door sensors, light sensors, water sensors, temperature, pressure 
sensors, etc. 

Action: This is any name you wish to call the action that occurs. 

For example, triggering a sensor (by breaking a circuit , opening the circuit)  this can 

be set as an output to turn the lights on. You can simply name it Turn Lights On) 
Copyright © 2019 Global Technology Asset Partners Inc.  
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Select Output: This is the output you wish to activate (or for that matter deactivate) 
Activation duration: This is the duration or time to allow this action to occur. For example, 
a camera detects motion and you want to turn the lights on for 3 seconds. After 3 
seconds the I/O would resume to its previous state (or turn the lights back off ) 

Record Video (from other cameras) 

This feature allows you to record video from other cameras when motion occurred on 
one camera.  For example person walks in a room and the door camera triggers motion. 
Using this Action you can instruct Visec to also record from all other cameras. 
Simply check the other cameras you desire to record from and also indicate the duration 
(how long) to record for. 

Seek Axis PTZ Camera 
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This feature allows you to have a PTZ camera (currently only Axis models, others to be 
added soon) to be directed to a location when motion is detected. For example, if motion 
were detected in one camera you could then automatically instruct Visec to PAN TILT 
and ZOOM to any preprogrammed area. E.g. a car drives on to a driveway, you can 
program Visec to direct your other PTZ cameras to zoom into the entrance. You can 
create an entire chain of cameras that activate and PTZ to the desired location based 
specific events. 

Send Email Notification 
This feature allows you to receive emails when motion is detected. 
E.g. someone walks in your home while you are not home, you can receive a set of
emails seeing this motion. This can alert you to possible intruders that come on your
premises without authorization.

To use this feature Select email Notification 
Select: Manage and then press Add 
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Account Name: This is any name you call the email account you are entering. E.g. work 
email. 

SMTP server: This is the smtp or outgoing mail server provided by your isp or email 
provider. For port enter the port provided. The standard ports are 25, or 587 

POP3: This is the pop3 or incoming mail server provided by your isp or email provider. 
The standard port is 110. 

Authentication: 
Select the Authentication provided by your isp. 
If your SMTP requires a login and password enter it at the bottom where shown. 

When done press OK  
Since you can have more than one email account, all your email accounts are shown in 
the email account manager where you can edit, add a new email or remove an email. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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Press Ok again and you will be returned to the main email screen. 
Make sure to complete this as follows: 

Action: You can call this anything you want, For example Send e-mail notification 

to ... 

Copyright © 2019 Global Technology Asset Partners Inc.  
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Account: This is the email account you want to use to send the email alerts 
Send To: This is the email address you want emails to be sent to 
Copy To: This is a carbon copy (or duplicate) email address 

[ ] Send Alert using a schedule 

This allows you to only receive emails using a defined schedule as shown below. 

For example, suppose you have a camera in your store or office during normal business 
hours. Also, suppose that there is constant motion from people in the store but you do 
not want VISEC to send you alerts during business hours. With scheduling, you can 
control when alerts are sent so that they are sent only after business hours. 

Message Format- select if you want to receive the alert in plain text or html. 

Plain text sends without formatting and attaches the image(s).  
Html however sends the email in a more organized format with all images nicely 
organized in your email message body. E.g. photos are displayed chronologically from 
top to bottom similar to a series of slides. 

Most email programs, and cell phones now support html email. In addition, almost all 
providers such as Yahoo, Gmail, AOl, Hotmail, etc., all have html support. 

Test Message - Pressing this button will email you a test email notification based on 
your specifications above. Press this to make sure your email account settings are 
correct. If you receive an error message, double check your email settings or contact 
your ISP for help. 

Filters 

The Filters Menu allows you to manage the following: 

1) Right clicking on the camera window -> Choose properties

Copyright © 2019 Global Technology Asset Partners Inc.  
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b) Or Choose View Devices -> Properties -> Filters

Deinterlacing:  If you use ANALOG cameras you will want to deinterlace the video 
which removes the jazzed and boxy lines. This usually only applies to analog cameras 
from capture cards, tv cards, or usb capture devices. Simply the option you prefer, we 
recommend “BLEND FIELDS” for the best output.  

Resize: If you require you can reduce the size of the recorded video by 50% or 25%, 
just select this radio button. 

Rotate: this feature lets you rotate the camera window. For example if the camera is 
mounted upside down, or side ways you can choose to rotate the picture.  This is a lot 
easier to do in situations where the camera can not be rotated itself. 

Recording  

This feature lets you manage how Visec records. 

[ ] Enable time lapse recording, interval ___ seconds 

This feature allows you to automatically record 1 image (frame) anytime you 

want. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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[ ] Record Video when motion is detected including: 
up to_____ seconds before motion _____ seconds after motion 

This feature allows you to record when motion is detected before and after. 
VISEC's motion detection feature will work with any camera. No external hardware 
sensors are required. Motion Detection is based on a complicated series of algorithms 
combined with pixilation technology and object recognition technology to form the basis 
for software controlled motion detection. 
Again, No external motion sensors are required. 

Motion sensitivity can be configured in the camera window. 

[ ] Insert Time Stamp – this will insert a graphical (raster) time stamp on the image. 

Maximum Recording frame: You can specify here the frame rate to record at.  

In the picture below, Visec is set to record 1 image every 60 seconds for this particular 
camera. 

We are also instructing Visec  to record 1 second before motion occurs and 2 seconds 
after.  For example if someone walked in a room, and the camera detected them (motion 
was triggered) Visec would record 1 second before this occurred, and then for 2 seconds 
automatically after this. Visec is recording at the full frame rate of the camera pending 
the CPU availability. 

Guard Area 

Many times a camera is positioned to display a large area. 
Sometimes in this area, you may only want the built in motion detection to monitor 
selected regions of the area and to ignore other areas. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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The guard area feature lets you select targeted regions that will be monitored by the built 
in motion detection, while ignoring others. 

To use the guard area. 

1) Right clicking on the camera window -> choosing properties

b) Or Choose View Devices -> Properties -> Guard Area

Place a check next to the box that says Use Guard Area 

  Use Guard Area 

Press the Add button and you will see a selection shape appear on your image. 
Click that section and move it to the area you desire to monitor. 
You can expand, shrink and move this around. 

Once you have defined the areas to monitor, choose a Sensitivity level to monitor. The 
higher the number, the more sensitive it is.  (don't confuse this with the regular motion 
settings,  most users will select 100% for Sensitivity.) 

You can press the Add button to add more regions. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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To delete a region, select it and then press the delete button. 

Once the regions for the Guard Area are defined, press the OK button to save them. 

Note: Only the areas with a BOX are the areas you are specifying to monitor.  
So everywhere that does not have a box to mark the target areas, you are telling Visec 
to ignore detecting motion. 

Miscellaneous  

The miscellaneous menu allows you to do the following: 

 Display camera name on Window 
checking with display the camera name on the window 

 Display record indicator on camera window 

 Display motion indicator on camera window 
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License Plate Recognition- LPR 
If you purchase a LPR license you will see this tab: LPR 
To activate LPR first you must 

You can configure VISEC by choosing Edit and then Preferences -  then - LPR 

Or Press the (wrench icon button)  and then select -> LPR 
You must under License Plate recognition: Select default engine 
Then press: OK 

Copyright © 2019 Global Technology Asset Partners Inc.  
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License Plate recognition must be enabled per camera. To do so: 
Right click on an open camera window -> Choosing properties  Then LPR 

b) Or Choose View Devices -> Properties  Then LPR

Check:  Use License Plate Recognition on this camera 

[ ] Use by-frame processing interlaced video source  

 Only check this you are using an analog camera 
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[ ] Process frames only if motion was detected 

The Visec LPR engine is processing all frames, regardless of movement looking for a 
license plate. Since LPR is a heavy CPU process, using this feature is very beneficial. 
Checking this box will only process frames when Visec detects motion.  Considering 
99% of LPR there is a car moving, this is a great resource saving feature to use if the 
situation allows. 

Engine Settings 

This menu lets you configure the LPR engine settings 
Character Height : This is the range of the character of the license plate as shown 
below. In the image our letters are around 25 pixels of height. The recommend character 
height to put is 8-64 
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Country Code: Select the Country Code you are located in. This will configure the best 
match for your country. 

Plate color format: Select the format of how the license plate you are doing LPR on is 
setup. Select, Dark characters on a light background or Light characters on a dark 
background. You can also select any format to do both. 

Contrast Level- Select the contract level.  
We recommend medium for most situations. 

Video Quality- Select the video quality.  
If the camera displays a decent, and readable license plate image, select „Normal‟ 
If the camera has limited light and there is noise (pixel patterns or distortions) select „low 
light and noise‟ 

If the camera has limited light, noise and some blurriness select the last option. 

Copyright © 2019 Global Technology Asset Partners Inc.  
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[ ] Histogram Equalization 

This is a special image contrast that globally changes the color intensity. Its very useful 
for backgrounds and foregrounds that are either both dark or both bright.  
Note the default value of this is un-checked. 

Rotate Angle:  
The best LPR image results are from level images. This feature will rotate the image 
prior to processing. Use this if your camera is at a non level angle (e.g. mounted 
sideways).  

Processing Threads.    
Usually the number of CPU‟s you have is the number of threads. (unless you are running 
hyper threading). Since LPR can utilize a great deal of resources, this feature allows you 
to limit how much processing you will allow for LPR so your computer will run normally. 
It‟s best to keep this at 50% of your available threads. (usually 1-2 threads) 

LPR-Configure Regions and events 

Lanes- a lane is a region on your camera you want to detect plates. This area is the 
location the license plate will most likely appear. Visec automatically creates a default 
lane (default window) for you as shown in the image below. 

You can expand the lane by clicking and dragging the shape. 

The window name can also be changed from Default Window to another more specific 
name.  

Note: If you have a megapixel camera you can also have one camera do multiple lanes 
by pressing the NEW button. In this case you could have 2 lanes processed by one 
camera. 

Events And Actions 
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Visec allows you to customize how LPR will work best for you. 
Once a license plate is detected you can instruct Visec to perform certain actions and 
events. 

By default when you enable LPR, an action called “Display Alert Add Message to Visec 
Log Window” is automatically added. What this action does is basically add the license 
plate when detected to the log window as shown below 

Pressing the ADD Action button will add new LPR events as shown below: 

The drop down box shows Predefined Actions 
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Replace Improper license plate – This is used to pre-program a plate that may be 
detected incorrectly and replace it with the correct plate 

Ignore and stop processing- This will stop future processing of the sequence of 
actions for this plate. 

Display Alert Window -This will display an alert window and sound when a plate is 
found.  The alert window shows the actual plate cropped and then above it what the LPR 
engine processed it as. 
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Force recording for __ seconds.  This will force Visec to record video from the camera 
for a specified interval. 

Write log file for selected camera- This will save a log file for the plate found. 

Create a New Advanced LPR Action 

Advanced Actions are covered in the Action Sections Above 
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Remote Access 

Remote Access lets you connect to your computer from a remote computer using a web 
browser and an Internet connection. It allows you to see live and stored video. For 
example, if you are out of town you can connect to your computer to see live or historical 
video of your home or office. 

Remote Access is best used with dedicated Broadband Access such as DSL, CABLE , 
T1, or LAN access. You can also use Remote Access with a dial up connection, but you 
will need to keep your computer constantly connected to the Internet.  

To Enable Remote Access: 
(Note: you may need someone with technical assistance to help you.) 

Choose EDIT, then Preferences 

Check the box titled  Enable remote access service. 
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Type a login (username) in Administrator login field 
Type a password in the Administrator password field. 
Next type in your computer's IP address if you know it, or click Determine IP address. 

Port: Most users will select port 80.  
Important: Some ISP's block port 80. Check with your ISP to see if they block Port 80. 
If so, then you may need to change your port to a different port such 808, 8080, 9121 
etc.  

Router Configuration 
Users behind a router need additional router configurations to make a connection.  
If you are using a router or firewall you can configure TRIGGER PORTS to allow access. 
(A router or firewall may require you to point a specific port to a specific IP address in the 
network) 

Users with DHCP enabled may need to configure a static IP address locally within Local 
Area Network (LAN). 
*Router configurations are required by most ISPs for your own security.
The Visec Software is designed to make this process as easy as possible.
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Remote Access- user list 
Visec allows you to create users that can login remotely with reduced access. For 
example you can add a new user and limit the user to specific cameras.  Such as a 
secuity guard, you only want the security guard to be able to watch video and not 
be able to delete video. 

Simple press Add to add a new user. 

Enter a user login, password, and select the cameras the user has access too. 
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Using the Dynamic IP Support Feature 

Most users of DSL and Cable Modems are assigned a new IP address each time they 
connect to the Internet. Because this IP address changes, it's hard to keep track of it.  
Imagine you are out of town and VISEC detects motion and emails you an alert. Its 
possible that the IP address is changing every time VISEC establishes a new Internet 
connection. 

Since most users do not know how to find their IP address, this login feature will 
automatically find it for you and allow you to easily use the remote access feature. 

Under EDIT, then Preferences – Remote Access   If your IP address changes, 
check this box 
When you check this box, VISEC will send your IP address to our www.visec.net 
website. 

You then visit www.visec.net click on members login. VISEC will internally send back 
your IP address. 
This is beneficial because you do not need to know your IP address, and VISEC will 
automatically find it for you, allowing you to easily use the remote access feature. 

If you know your IP address and you want to view video remotely. 
Open up a browser and type in your IP address.  
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Example: http://youripaddress:yourportnumber 
Skip steps 1-3 below.  Start at step 4.    

If you want to use the easy login feature that keeps track of your IP address for 
you, allowing you to view video remotely then complete the following steps: 

1. Go to www.visec.net/signup.php
Fill in the form and click Create Account

2. Go back to the VISEC program: Choose EDIT, then Preferences – Remote Access
(on the bottom half of the screen window)

Select: If your IP address changes, check this box.

Type in your Website Username and Password that you just entered on the VISEC 
website. (If this information doesn‟t match, you will get an error later that says failed to 
send IP address) 

Click OK. 

Now Try It: 

3. Go to www.visec.net/members.php  (This is the login portion of the website that was
explained above, where Visec is able to keep track of your IP address and make the
login process easier for you).

4. Enter the password that you chose for the Remote Access (located again at:
EDIT, then Preferences – Remote Access (Top Portion of this screen).

5. If you followed the above steps correctly you should now be logged in.

http://www.visec.net/signup.php
http://www.visec.net/members.php
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The next screen should show you several options: 
-Click here to view video history
-Click here to view live video
-Users with limited scripting support, click here for live video

-Click here to view video history
This will show images that have been previously recorded.
Choose the date to view the video history.
Click Submit.
You can choose Playback Mode to see a movie created from the images.

-Click here to view live video
This will show live video footage of what the camera sees.
Select the refresh rate per seconds.
Choose Live to see exactly what the camera sees.  Or you can choose to see an image
taken every 1, 2, 3, 4, 5, 10 or 20 seconds.
If the camera does not automatically refresh, click on Click here if camera does not
refresh.
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Click Select Camera if you have more than 1 camera set up and you want to specify a 
specific camera. 

-Users with limited scripting support click here for live video
This will allow users who do not have Java script installed to view live snap shots.

You can choose to refresh the image every few seconds, but it will not show live video 
running continuously. 

If you encounter problems review the troubleshooting at the end of this manual. 

* Note if you get an error while trying to login with this service and your settings are 
entered correctly this is because some ISP‟s and/or some Routers may not allow you to 
access your Physical IP address from within you‟re Local Area Network (LAN). You will 
be able to do this from any outside network though. If you wish to login within your LAN, 
you will have to login using the local IP address and the port number. For example: try a 
local IP:  http://192.168.123.114:8199 instead of http://65.322.323.2:8199.

**This service does not upload any video surveillance to our Visec severs. The service 
provides you with a link to your IP address, where you are connecting to your personal 
computer. Visec has no way to monitor your cameras and your privacy is always 
assured. 

Note: We also have an application you can use for remote access instead of your 
browser called VRV (Visec Remote Viewer). You can download this 
from:www.visecpro.com  under downloads. 
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Countdown 

Just like a regular alarm system, VISEC can countdown before it is armed. 
To use this option, choose Camera, then select Countdown and then enter the time in 
seconds and press Start. 

Once you press start, VISEC begins its countdown. 

From here you can then open a camera window. No motion or alerts will be stored until 
the countdown is complete. 
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Reviewing Video Coverage 

To review recorded video coverage, press the video tape icon. 

You will then see a new window appear with buttons similar to a DVD player. 

Simply select the date and camera to play the video coverage. 
You can use the buttons to pause, rewind, forward or stop as needed. 

New Feature: When you double click the camera window VISEC will play back the last 
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- 10 seconds of video that was just recorded. You can pause, print, save and export
video.

You can export video by pressing the play / pause button and then the export button 
directly in the playback. You can also export a segment of the video clip needed. First, 
start by moving the slider to the desired start position and pressing set frame.  Then 
move the slider to the desired end position and press set frame, followed by the Export 
Button. 

Frame By Frame Playback 

When reviewing playback video, you can press the pause button, to pause, and then use 
the left and right arrow keys to advance frame by frame. This is very helpful when trying 
to pinpoint an exact crucial piece of video. 
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TROUBLESHOOTING 

Hot Key does not work. 
Program Crashes 
Remote Access Does Not Work 
Camera Window Too Small 
Can not see Video 
Can not send notifications by email. 
Motion Detection Too Sensitive, or not Sensitive enough 
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Hot Key does not work 

The Hot Key Function is setup to allow VISEC to run in Secret Mode. Pressing the Hot 
Key (which you created in the menu) will make the program reappear and once again be 
visible on the monitor. 

If a Hot Key does not work, simply change the Hot Key by entering a new key 
combination in the box below. Make sure to test this Hot Key by pressing the Test hot 
key button below. 
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Program Crashes 

VISEC was developed by a team of NASA level software engineers who are truly 
masters of coding. Visec utilizes the latest architectural designs and embraces the 
utmost software engineering standards known today. The software has been thoroughly 
tested on all major computer systems. 

VISEC is very stable and can run for weeks without needing to be rebooted. If VISEC 
crashes on your system it could be due to low memory, a slow processor, or too many 
applications running. 

We suggest that you close some large applications that may be significantly utilizing 
your computer's resources. 

Finally, please check your computer system to make sure that you have enough memory 
(RAM) and available disk space. VISEC can run with as little as 512 megabytes of RAM, 
but 1 GB of is recommended for optimal performance. 

In addition, antivirus programs and firewalls (software/hardware) may give the illusion 
that VISEC is not working, when in fact it is being restricted. Make sure to add VISEC to 
your antivirus program/firewall or switch off these software based applications when 
using VISEC.  

If Visec does crash for whatever reason, you can choose to send us the crash report 
where we can analyze it.  
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Remote Access Does Not Work 

The most common problem is an incorrect setup as shown below: 

Incorrect IP Address: Your IP address is changing and you are not correctly entering 
the correct IP address. Make sure that you use the correct IP address. The correct IP 
address is the IP address that was assigned by your Internet Services Provider, or by a 
Network Admin. 

Router or Firewall not setup: 

If you are sharing an IP address, the most common problem is that your system needs 
to be configured at the router level. Since your network may have one IP address, you 
need to instruct your router which computer is which. 

For example, suppose your office has 6 computers, but there is one IP address. In a 
situation like this, you will need to configure your router to use a specific port for each 
computer application you want to run VISEC on. 

The most popular way is to assign what is called a trigger port. 
For example, you can tell the router that if data is sent to a certain port, to redirect it to 
your computer. 

Example #   
207.103.30.3, with port 8010 take to : YOUR COMPUTER (192.196.123.170) 

Example #   
207.103.30.3, with port 8020 goes to a different computer (192.196.123.171). 

This configuration may require a networker with experience to assist you. 

Note: If you are running DHCP, you will need to assign a static IP address to your 
computer, otherwise there is no way VISEC can know which computer is yours on the 
network. 
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Camera Window Too Small 

Make sure to update the camera placement layout 

Either press the button continually to change the display or press the arrow next to the 
button to select the desired placement
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Possible Problems of Video not showing 

If you have problems seeing Video, here are some of the possible reasons: 

a) Incorrect Camera

The first possible reason is that you are choosing the incorrect camera. It's possible that 
you had installed other cameras before that are no longer active on your system.  

Click on "View Devices" to show the list of cameras available on your computer. 

Make sure to only check the box(es) of actual cameras connected to your system. 

b) Camera not installed correctly

USB- make sure your cameras are plugged in correctly and you have the proper driver 
installed. 

Analog Camera – If your camera shows in view devices but you do not see a picture or 
you see a black screen, make sure to check the camera is property powered. Also make 
sure the connectors are tight, and no wires exposed. 

IP Cameras – The most common reason for IP cameras not working are improper 
setup. Many users think entering the ip address only is all that is needed. The 
Address/URL must be entered in a specific format (usually automatically found. 

Capture Card 
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If you are using a capture card, not every capture card will work. Most capture cards are 
designed to work only with the software that came with the card.   

For the card to work with VISEC, it must have all ports (video outputs) controlled by a 
dedicated video processing chip, and each port created with WDM support.  

WDM is basically a driver model that is common in Windows 98 and above. You can 
think of USB devices such as web cams, as WDM devices. Basically a WDM device 
works almost instantly on any computer. This is because the driver is coded to work 
universally. A capture card that is developed using WDM works similarly, in that only the 
driver is needed. 

The problem with many capture cards on the market is that they are restricted to only 
work with the software program included by the manufacturer and not 3rd party software. 

Again, the important point to remember is that many cards will not work with VISEC 
because the company that produced this software, has specifically restricted any third 
party software, and only supports their own software. 

64 bit windows- Visec works with both Windows 32 bit and 64 bit versions, however 
many capture cards do not. Most capture cards on the market still only have 32 bit 
drivers. This means if you have a 64 bit windows version and you don‟t have a 64 bit 
driver your capture will not work.  

You can visit www.visec.net  to find a list of affordable and professional capture cards. 

Can Not Send Email Notifications 

Notifications are basically email messages with optional photos attached to alert you 
when motion is detected. The most common error is an incorrect configuration. 

Your local Internet Service Provider (ISP) should be able to give you the correct settings. 

Most problems include: 

(a) Incorrect settings- Many ISPs use case sensitive usernames and passwords.
Make sure the username and password you use are in their correct uppercase and lower 
case formats.
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(b) Your ISP may require additional security to allow access to send the email. You may
need to complete the configuration section that says "my server requires authentication."
Check this for ISP's that require authentication.

(c) Make sure your ISP provides you the smtp port (usually 25, or 587)  and provides
you a mail server address to let you send email.

(d) Make sure no firewall programs or software are restricting your computer to send
email.
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Motion Detection Too Sensitive, or not Sensitive enough 

The level you set for motion detection determines the sensitivity level that the camera 
will record motion. 

For example, someone running in front of the camera would produce more motion than a 
person sitting on a chair. 

VISEC lets you adjust the level of motion detection you desire. 
You can control the sensitivity by adjusting the Trigger lever slider shown below. 
25% is the default level. 

Trigger Levels tell you the percent of motion. Usually this level is 0% - 3% if the camera 
has nothing moving in front of it. By moving the TRIGGER slider you can specify the 
level you want to record motion.  

For example, if your camera is set to 25%, this means that anytime there is motion at 
25% or greater, the system will record this activity and send an alert. Anything less than 
25% will be ignored. 

The lower the range, the more video that will be recorded. The higher the range, the less 
video that you will record. 

We suggest leaving the motion set to 4-15%. This will record a normal level of video 
surveillance. Also make sure your camera is clean and has no dust on the lens. 

Note: The color of the box next to the trigger will change from blue to red when motion is 
detected. When the color is red, video is being recorded. 

Slow Motion- A new feature we developed is Slow Motion. This works to detect very 

small movements that can occur (e.g. like in the movies when someone walks very 
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slowly to avoid motion sensors). Usually what our Slow Motion feature does is make the 
motion become very sensitive. If the motion appears too sensitive, make sure "Slow 
Motion" is not checked. You can see this feature by right clicking on the camera window 
as shown in the picture below. 




